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Capturx for ArcGIS 

Welcome to Capturx for ArcGIS Desktop 

Thank you for your purchase. Now you can put the power of digital pen technology to work. 

Capturx for ArcGIS Desktop is an easy-to-use, digital data collection solution that enables 

you to keep using paper maps. Our extension is the ideal way to create, import, edit, share, 

and act on paper-based data in and between ArcGIS. 

  

With Capturx for ArcGIS Desktop, Capturx Pen Manager and Capturx Mobile software you 

will be able to: 

  

 Print maps with various feature layers on ordinary paper. You can select a feature 

from the printed legend and then draw it on the map. When the digital pen docks 

with the PC, the data (including the classification of those features) automatically 

gets updated within the geodatabase. 

  

 Use Capturx Pen Manager or Capturx Mobile to upload your data. Capturx Pen 

Manager also enables you to manage the features and options available on your pen 

and to send the file containing the ink via email. 

   

This guide describes the process for using Capturx for ArcGIS Desktop and Capturx Pen 

Manager software and provides a comprehensive explanation of their features. 

  

How This Guide Is Organized 

The topics and information in this user manual include: 

  

 How to charge and use your pen 

 Registering and activating your software and pen 

 Using Capturx Pen Managers 

 Capturx for ArcGIS overview 

 Using the Capturx for ArcGIS extension and toolbar 

 Opening a map and creating a legend 

 Printing your digital map layout and legend 

 How to use Capturx for ArcGIS Desktop to create data 

 Uploading data from the pen to ArcMap 

 Troubleshooting and maintenance 

  

These sections and topics will help you learn to use Capturx for ArcGIS Desktop. 

Charging and Using Your Pen 

The pen looks and feels just like an ordinary ballpoint pen, and you use it in the same way. 

There are no keys to press. You activate the pen simply by removing the cap and deactivate 

it by replacing the cap. The pen needs to be charged before you can use it to capture data. 
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To charge the pen: 

  

1. You may need to place the ink cartridge in the pen. To place the cartridge in the pen, 

take one of the ink cartridges and gently slide it into the hole at the tip until it is 

completely seated and does not fall out.   

2. Attach the docking station to a PC or laptop via the USB port. 

3. Fully insert the pen in the docking station. 

4. The gold connection points on the pen and docking station need to be aligned and 

the pen needs to be firmly placed in the docking station. 

5. After you connect the USB port to your computer and dock your pen, you will initially 

need to keep the pen in the docking station for four hours for it to fully charge. 

  

Note: To prevent your battery from running low, do not leave the cap off the pen for 

extended periods of time. You will need your pen cap, so keep it in a place you will 

remember. 

  

For information on how to use the pen and docking station to upload data, see Downloading 

Data from the Pen to ArcGIS. 
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Registering and Activating 

Registering and Activating Your Software and Pen 

After installing Capturx for ArcGIS Desktop, you will be prompted to complete the following 

steps for registering your software and activating your digital pen(s). The steps include: 

  

 Registering your software 

 Activating the pen 

 Registering the digital pen(s) 

 Importing the digital pattern for printing from your digital pen 

  

Registering and Activating Your Software 

You register and activate your Capturx software by filling out a registration form. You 

activate the software by docking the pen. When you first open Capturx for ArcGIS Desktop, 

you will see the following activation screen: 

  

 
  

The orange arrow shows you the step you are on in the activation process. To register your 

software with Adapx, select the Next button. This will open the Register Software form. 
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To complete the registration process: 

  

1. Fill in the form with the required information. 

2. Select the Submit Online button so submit your registration information. If you 

cannot submit online, you can select the Save Button to save your registration 

information.  Select the Remind Me Later button if you want to complete the form 

later. 

   

To complete the software activation, dock the pen and select the Next button. 

  

 
  

Registering and Activating Your Pen 

The first time a pen is docked, you will see the Capturx Pen Startup Wizard. The green 

arrow shows you the step you are on in the activation process. The check mark denotes the 

parts of the process that have been completed and the warning sign denotes a procedure 

that failed. 
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All new pens shipped with Capturx for ArcGIS have been activated. If you are using a pen 

that was purchased with different software, you may need to manually activate.  

  

If the pen is not registered, then after activation the green arrow would go to “Register your 

pen with Adapx” and then you could select Register and bring up the Register Pen dialog. 

  

To register your pen: 

  

1. Select the Register button to open the registration form. 

  

 
  

2. Fill in the form with the required information. 

3. Select the Submit Online button so submit your registration information. If you 

cannot submit online, you can select the Save Button to save your registration 

information. The registration details are saved to file, so you can print the 



Registering and Activating 

Capturx for ArcGIS Desktop v1.3  6 

registration information and fax it or mail it to Adapx. Select the Remind Me Later 

button if you want to complete the form later. 

  

If your connection uses a proxy server, you may have to enter proxy information to 

complete the activation. 

1. When Capturx displays a communication error: 

 

 

2. Click on the More>> button and then the Proxy... button. 

 

 

3. Enter your organization's proxy settings and click OK. 

 

 
  

  

If you had pattern on your pen you have the option to install pattern. When you click 

Install Pattern, the pattern is installed on the machine and removed from the pen. 
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Using the Pen Managers 

Managing Data on the Pen 

There are two ways to manage Capturx for ArcGIS data collected with the digital pen. 

Capturx Pen Manager and Capturx Mobile can be used to download your ink data to a local 

desktop, send your ink to an email address, or save your ink to a folder. In addition, 

Capturx Pen Manager also enables you to manage the features and options available on 

your pen. Listed below is an overview of Capturx Pen Manager and Capturx Mobile features 

and links to user guides. 

  

Capturx Pen Manager 

Capturx Pen Manager is installed on your computer as a first step when you install Capturx 

for ArcGIS. Capturx Pen Manager allows you to manage the ink you upload when you dock 

your pen. Using Capturx Pen Manager you can:     

  

 View the docked and/or locked status of the pen 

 Enter and save personal info on the pen 

 Assign a password to the pen 

 Set as a “Customer Reference Pen” for accessing additional services 

 View the remaining time left on the battery of the pen 

 Download or delete pages on the pen 

 Choose pen download options 

 Activate the pen for enterprise enabled applications  

 Enable/Disable the Bluetooth feature on the pen 

 Register the pen 

 Enter an email or server address for sending ink records 

 Install additional pattern 

 Get updates about new versions of Capturx software 

  

For more information on Pen Manager for Windows and its features, see the user guide: 

http://adapx.com/support/capturx-pen-manager-digital-pen  

  

Capturx Mobile 

Capturx Mobile allows you to use your mobile device to send your pen data to an email 

recipient. With Capturx Mobile, you can: 

  

 Bluetooth pair your digital pen to your mobile device 

 Use your mobile device to send the file containing the ink via email 

 Use the GPS mode to set and view location information about your uploaded file 

 See a log of recent activity with a date and time stamp 

 Easily email Adapx product and technical support 

  

For more information on Capturx Mobile for BlackBerry and its features, see the user guide: 

http://adapx.com/support/capturx-mobile  

https://www.adapx.com/support/capturx-pen-manager-digital-pen
https://www.adapx.com/support/capturx-mobile
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Capturx for ArcGIS Desktop Overview 

Capturx for ArcGIS Desktop Overview 

The following diagram shows the overall process used to capture, review, and edit digital 

pen data. This includes the steps involved in: 

  

 Preparing and printing your map and legend 

 Using the pen to create ArcGIS data 

 Docking the pen and transmitting the features you have created 

 Reviewing and editing your changes using the Capturx ArcGIS Desktop extension 
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Using the Toolbar and Buttons 

Overview of the Toolbar 

At the most general level, the Capturx for ArcGIS extension toolbar is used to: 

  

 Add a Capturx Redline/Markup layer to your map 

 Print the page layout containing the map and legend you have selected 

 Use the import options to import the ink strokes you have made on your map so 

they can be reviewed and accepted or rejected 

 Use the review options for selecting features you created 

 Accept or reject edits 

  

The States of the Toolbar and Buttons 

The toolbar consists of 12 buttons and some of these buttons will be disabled (grayed out) 

depending on where you are in the process of capturing and reviewing your field data and 

whether you are in layout or data view. As shown below, the toolbar can be in different 

general states with different options disabled: 

  

Toolbar 

Button 

How It Is Used 

 

Add Redline/Markup Layer: This button is used to add the Capturx 

Redline/Markup layer that you can use to write notes on your map. This takes 

you to a dialog box that enables you to: 

  

 Select the data frame you want to apply the layer to 

 Provide a name for the layer 

 Select the path to the location where you want to store the files. 

  

Note: The layer will have the same coordinate system as the data frame. 

 

Print Page Layout: This button is used to print the page layout. This takes 

you to the print dialog. 

 

Import Next Session for Current Map: This button is used to import the 

oldest ink session for the map document (.mxd) that is currently open and 

your new features will appear on the map in an ArcMap edit session. This 

button is only active if there are ink sessions waiting for the currently active 

map document. 

 

Open the Session Dialog Box: This button will show you a comprehensive 

list of ink sessions you have uploaded using your pen so you can choose an 

ink session from the list. This dialog includes the: 

  

 Name of the map document where ink session imports will go 

 User name associated with the pen 

 The time and date the upload was received 

  

You can also use this dialog box to delete an ink session. Ink sessions that 
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correspond with other map documents will be grayed out but you can select 

them and automatically open the corresponding map document (.mxd). 

 

Select All Capturx Features: This button is used to select all of the features 

(except Redline/Markup strokes) you have added to your map. 

 

Clear All Selected Features: This button is used to deselect any of the 

features you have selected on your map 

 

Select the First Change: This button is used to select the first feature you 

made on your map 

 

Select the Previous Change: This button is used to select the previous 

feature on your map 

 

Select the Next Change: As you move through the changes you have 

made, this button is used to select the next feature you made on your map. 

 

Select the Last Change: This button is used to select the last feature you 

made on your map. 

 

Reject All Changes: This button is used to reject all of the changes you 

made to the features on your map. You will be given the option of reverting 

your changes or removing and deleting all the data from the map.  

 

Accept All Changes: This button is used to accept all of the features and 

changes to those features you made on your map. 
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Opening a Map and Creating a Legend 

How to Open a Map and a Legend 

A legend, when printed with Capturx for ArcGIS, becomes a digital palette for creating 

features. This section describes the process for opening a map to create and place the 

legend you will use to add features to your map. This includes: 

  

 How to open the map you want to use with Capturx for ArcGIS Desktop 

 How to use the ArcMap Legend Wizard to select the layers you want to include in 

your legend. 

  

To create a map and legend: 

  

1. Open ArcMap. 

2. Select the map you want to use. 

  

 
  

3. Once you have a map with data layers added, From the View Menu, select Layout 

View. 
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4. From the Insert Menu, select Legend. 

5. Use the Legend Wizard to select the layers you want to include in your Legend. 

  

 
  

6. Select Next in each dialog box after closing the style sessions. 

7. Select Finish on last dialog 

8. The items you have selected will appear in the legend. Note: You can also right-click 

on the legend once it has been added to your layout and choose Properties to 

modify it later. 

9. Use your mouse to drag it to the desired location on the map and to re-size it. 
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Printing Your Map and Legend 

Selecting Pattern to Meet Your Needs 

When you print with Capturx, a digital dot pattern (sometimes called a digital watermark) is 

printed on the paper along with your map layout. Before you print, you need to know how 

this pattern is used when you print your map and how to select the pattern size that best 

meets your needs. This section describes: 

  

 How the pattern is used to print your digital map 

 How to use the Printing dialog box to learn how much pattern you have available 

 How to get more pattern when you are running low 

  

How the Pattern Is Used to Print Your Digital Map 

Digital pattern is required to print the digital map you will use. Pattern is available in 3 sizes 

(A0, A2, and A4), and each size has an exact number of pages available for printing. These 

pages are referred to as a "shelf" of pattern. 

  

 
  

What you plan to print Option to choose 

I will ONLY print LETTER size 

maps (8-1/2” x 11”) from this 

computer 

Select A4 

I will print LETTER (8-1/2” x 

11”) and TABLOID (11” x 17”) 

size maps 

Select A2 

I will connect this PC to a 

PLOTTER (you will still be able 

to print smaller sizes) 

Select A0 

  

A larger size pattern can be used to print a smaller size page layout. For example, one-

square-yard “A0” can be used to print a letter-size 8.5” x 11” page layout. However, there 

are fewer pages in a refill of a larger size pattern, so it is more cost efficient to use the 

smallest size pattern you can. If you have more than one shelf of pattern, Capturx will 

automatically choose the smallest sized pattern possible in order to conserve pattern pages. 

  

If you have downloaded pattern that is too large for the size you would like to print (“A0” 

being used to print a letter-size 8.5” x 11” page layout), you can still print. However you will 

see a warning notice in red text at the lower left of the print dialog noting that you could 

use smaller pattern. If you do not have an additional pattern credit available, you can 

purchase one by contacting sales@adapx.com. 
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Monitoring and Using Pattern in ArcGIS Desktop 

Capturx for ArcGIS provides you with a Pattern Refill dialog box and a Desktop printing 

dialog that you use to download pattern and to monitor the amount of pattern you have 

  

 
  

When you‟re in the Pattern Refill dialog, you have the option to download any size pattern of 

which you don‟t already have more than 1000 pages. If you already have more than 1000 

pattern pages, the checkbox for that size will be grayed out. 

  

The bars on the pattern control are full/green at 1000 pattern pages or more. If there are 

fewer than 800 pages left, you can find out exactly how many pages you have by hovering 

on that bar. Otherwise, the hover text reads „full‟. 

  

 
  

  

Printing the Page Layout and Legend 

The following section describes the process for printing the page layout and legend. This 

includes: 
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 The steps for printing the page layout and legend 

 A description of the map "Layout View" 

  

To print the page layout and legend: 

  

1. Within ArcMap, select printer options by selecting File>Page and Print Setup. 

  

 
  

2. This will open the Page and Print Setup window. When using this window: 

  

 Set your printer to use the size of paper desired as the “default tray”, since 

the “source” (paper tray) setting in this Page and Print Setup window is not 

currently supported 

 The “Scale Map Elements proportionally to changes in Page Size” option is 

helpful to keep your page elements (map, legend) within the area of the page 

that will actually be printed. 

 Select the “Use Printer Paper Settings” radio button 

 The image in the lower right corner of the dialog will show a visual 

representation of how your map will fit on the paper size and orientation you 

choose. If the image falls outside the page margin, you will need to choose a 

different setting. 
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3. You need to be in the Layout View to print your map. Select View>Layout View to 

print your map. 

  

 
  

This will display the map in “Layout View”. This view provides rulers and printer margins 

that will help you see the actual orientation of your page layout (portrait or landscape) and 

determine how the page is printed. 

  

By showing you the size of the page layout, these rulers also show you what size paper you 

should be setting your printer to use (make sure that the printer‟s “default tray” is using 

paper of that size.) As noted above, you must set the default printer tray to the size you 

like before printing or loading the appropriate size paper you are using into the default tray. 
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As noted below, in the Page Layout, you might want to keep anything you want to write on, 

such as a map frame or a legend icon, at least 7 mm away from the printer margins. 

  

1. Select the Print button on the Capturx toolbar to print current layout. 

  

 
  

Note: If the legend has layers that are from data sources that Capturx cannot modify, or 

that are not fully compatible, a “Layer Support Information” form will pop up before 

printing. This form lists the unsupported layers and unsupported symbology (this is rare). If 

you see this form, you can cancel printing, or continue on to print. 

  

Even though these layers are not supported, you will still be able to print and markup the 

map. New features will not be created on these unsupported layers but all markups will be 

added to the Redline/Markup layer. 
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How to Use Capturx for ArcGIS Desktop 

How to Use the Pen to Create Features 

The following section describes how the pen and legend are used to add features on your 

map so you can update the desired layer with new information. This includes an overview of 

the two distinct functional states used by Capturx for ArcGIS to create data. 

  

Digital Pen Functional States 

To allow you to easily add new information to your map, the Capturx digital pen provides 

two functional states to create markups 

  

 The Redline/Markup mode is turned on by default and the line color can be changed 

by touching the legend item in the Capturx Markup layer 

 The Feature Creation mode is enabled by touching any feature symbol on the legend 
of the printed map 

  

The following sections illustrate the two functional states and how these are used to add 

features to the map. The following figure shows the layers for these options and how they 

are shown on the map legend. 

  

Legend in Layout View 

  

 
  

The Redline/Markup Mode 
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You are in Redline/Markup mode as soon as you take your cap off the pen, and the pen will 

stay in Redline/Markup mode until you make another selection from the legend. 

  

Feature Creation Mode 

As described in the section How to Open a Map and Select a Legend, you can  add additional 

layers to your map, to use with the pen and legend to add features. These function 

differently than the Redline/Markup options. When using the additional legend items: 

  

 Touch the pen to the legend for each separate entry you make on the map 
 Once you mark the map with the pen, Capturx returns to the Redline/Markup mode 

  

For example, after you mark the location of the Staging Point on the map, the pen returns 

to Redline/Markup mode so that you can add notes or sketch next to the Staging Point 

feature you just added. If you want to add additional Staging Points to the map, you need 

to touch the pen to the Staging Point symbol icon on the legend each time before you add 

the Staging Point feature to the map.    

                                         

Using the Pen and Map to Create Features 

The following section summarizes the process for creating features using the two modes. 

  

 By default, when you take the cap off the pen, you are automatically in 

Redline/Markup mode. The Redline/Markup legend consists of three colored lines you 

can use to draw free hand lines, sketch, or add notes to the map. The line colors and 

names can be modified to your choosing. You can select a line color at any time by 

checking the icon on the legend for the color markup you wish to produce. 

 You can select a different markup line color at any time and this selected line color 

will now "stick", and all future markups will use that new color until another color is 

selected. 

 To create a GIS feature, touch the legend symbol for that feature. The next pen 

stroke on the map page indicates where these features should be added on the map. 

 Once the pen is lifted from the paper, the mode returns to Redline/Markup. 

 You may select a different feature type by checking the appropriate symbol on the 

legend at any time, after which the next stroke will create that feature. 

  

Using the preceding example, to add a Staging Point, you would check that icon in the 

legend and mark the location on the map with a single dot of the pen. Then, when you lift 

the pen off the paper, the mode returns to the Redline/Markup and you can make a note on 

the map that a Staging Point is located here. You may want to write "SP" or draw a symbol 

that reminds you of what you added. 

  

You would switch to an another feature (Fire Truck) by checking that icon in the legend and 

then touching the pen to the map to add the fire truck, and then write the acronym „FT‟ next 

to the location of the fire truck to remind you it was added to your map. 

  

Note: For the pen to recognize the legend symbol, you need to limit the size of your mark to 

the size of the legend icon for that feature. Even a single "dot" by firmly tapping the pen tip 

to the legend symbol will suffice. This will prevent your ink strokes from accidently running 

into the adjacent feature symbol and "selecting" that feature for the map. Also note that the 
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digital pen does not work well at the edges of the map. Allow a 7 mm margin to ensure that 

your ink strokes are captured correctly. 

Downloading Data from the Pen to ArcMap 

This section describes how to upload the ink using the docking station and Capturx Pen 

Manager. 

  

After you have made your markups and you are ready to download your data, connect the 

docking station to your computer and insert the digital pen. Or use Bluetooth to send data 

from your pen to a mobile device. The following section takes you through this process.   

  

Downloading Data with the Docking Station 

If you want to download the handwriting directly to your computer, connect the docking 

station to your computer and insert the pen.  The docking station is used to dock your pen 

and to connect your pen to a PC or laptop via the USB port. The docking station consists of 

the base, insert, and the USB port you use to connect the docking station to your computer.  
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To download the digital ink from the pen: 

1. Attach the docking station to a PC or laptop via the USB port. 

2. Fully insert the pen in the docking station. The gold connection points on the pen and 

docking station need to be aligned and the pen needs to be firmly placed in the 

docking station. 

3. If you have Capturx Pen Manager configured to send your pen data to an email 

recipient instead of being processed on your computer, the email will be 

automatically drafted when the download is complete. If not, Capturx Pen Manager 

will start processing the ink records automatically on the same PC where the pen is 

docked. 

4. You can view the activity of your digital pen, docking station, and Capturx Pen 
Manager  
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Four states of the icon are used to show you status: 

  

 
  

Note: If you receive pen data via email instead of a docked pen, open the attached XID file. 

Capturx Pen Manager will process the ink as if the pen had been physically docked to your 

computer. 

  

Unsuccessful processing of pen data will result in an error dialog: 
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This dialog gives you the choice to leave the data on the pen (to try docking on a different 

PC) or to store the ink on the current computer while you troubleshoot the error. 

If you select the Stored Ink button from Capturx Pen Manager, there is an Import Errors 

tab which displays the following information for any pen data which wasn‟t able to be 

processed: 

 Handwriting image displayed on the right side of the dialog 

 Pen User Name 

 Date and time record was downloaded 
 Error message 

  

 
  

Import errors are most-commonly explained by the following conditions and can be solved 

with the accompanying actions: 

Condition Action 

Ink record was created 

with an Unactivated Pen 

Please activate the pen on this machine before attempting to 

import the ink. 

Capturx is unable to find 

the correct file 

Copy and open the original document on this computer, or import 

this XID on the computer where the document was printed 

Ink record has already 

been imported 

This ink record has already been imported. This can happen if you 

accidentally try to import the same file more than once. 

Unable to import ink 

record 

Unexpected error during import. Try rebooting the computer if 

this does not work contact Adapx customer support - 

http://www.adapx.com/Support/Contact-Technical-Support.html 

Ink record belongs to an 

application that has been 

uninstalled 

This ink record belongs to an application that has been 

uninstalled. To import this ink, please re-install the application or 

import it on a computer that has the application installed. 

  

  

Downloading Data Using using Bluetooth with Capturx Mobile 

http://www.adapx.com/Support/Contact-Technical-Support.html
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If you don‟t have access to a PC and want to send your handwriting to an email recipient, 

use Capturx Mobile instead of Capturx Pen Manager. 

  

1. Pair your digital pen with a supported mobile device 

2. Open the configuration options on the Capturx Mobile application 

3. Enter the email address where you want to send data 

4. Choose Direct Email as the upload method 

5. After collecting data, touch your uncapped pen top to the Send Data to Phone tick 

box on the laminated card. 

a. The pen will buzz twice telling you that the connection has been made 

b. The pen will buzz three times after the data has been sent to the phone 

  

For more information on Pen Manager for Capturx Mobile and its features, see the user 

guide: 

http://adapx.com/support/capturx-mobile  

  

  

  

  

  

Reviewing the Changes You Have Made 

After you have downloaded your changes, you can review them. The following section 

describes how you review the changes you have made to your map. This includes: 

  

 An overview of deleting and modifying features during the review session 

 Using the Session Selection window to choose the particular session you want to 

review 

 A description of the reviewing options available with the Capturx toolbar and the 

process for accepting or rejecting the features you have added. 

  

Deleting and Modifying Features during the Review Session 

When making changes to your geodatabase, ArcGIS Desktop only “edits” one data source at 

a time. Unlike standard ArcMap editing, Capturx opens an edit session for all databases 

(workspaces) at the same time and the active workspace will be determined by the „first‟ 

layer you added data to with the digital pen (priority is given to your layers over the 

Capturx Markup Layer). 

  

When reviewing and editing Capturx features, you need to be aware of which feature is in 

the “target” list in the ArcMap editor toolbar. If the feature you are reviewing is under the 

ArcMap “target” feature layer, you will be able to edit, delete and modify the geometry or 

vertices of the features as you normally would. However, if the feature you are reviewing 

belongs to a feature layer outside the ArcMap “target” layer, you can still edit the features, 

but you are limited to editing them through their attribute table. Editing the geometry and 

vertices of these features outside the “target” layer must be done outside the current 

Capturx edit/review session. 

  

Importing Your Review Session 

https://www.adapx.com/support/capturx-mobile
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After you have docked your pen and imported your sessions, you can use the buttons 

highlighted below to select, accept or reject the changes you have made to your map. The 

first toolbar shows you the options available in the layout view and the second shows you 

the options available in the data view. 

  

 
  

To review changes on the map: 

A. Select the Import Next Session button   on the Capturx toolbar to download 

the next session available on the current map so that your changes will appear on 

the map. 

  

Or 

B. Select Open Session Dialog Box button   on the Capturx toolbar and it will 

show you a current list of sessions you have uploaded. This includes the: 

  

 Name of the map 

 User name associated with the pen and can be defined in the Pen Manager for 

Windows 

 Time and date the upload was received 

  

1. Sessions displayed with green text are for the current map document. Sessions 

displayed with gray text are for map documents that are not currently open. Select 

the Import button to upload the desired session or double-click on the item. The 

Import button will start an edit session in the current map document or open a 

different map document if needed. If the target .mxd file cannot be found, you will 

have the option to browse for it. 
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2. The features you have made will be shown on the map. 

  

 
  

3. Use the Capturx toolbar to select all pending changes or to step through your 

features one at a time. The feature you select will be highlighted on the map. 

4. Use the Accept all button to accept all changes (reviewed or not) made to the 

geodatabase. Use the Reject all button to reject all changes (reviewed or not) made 

to the geodatabase. 

  

 
  

5. When you select the “Reject All” button, the following window appears — asking you 

to cancel the rejection, remove the session you have just imported, or to revert the 

session so you can re-import it again at a later time. 
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Troubleshooting and Maintenance 

Troubleshooting 

Below is a listing of common errors that can occur with the pen and Capturx ArcGIS and 

recommendations on how to resolve each of the issues. 

  

Missing Markup Layer in the Table of Contents When Importing the Ink 

1. When you create a markup layer and name it other than the default “Capturx 

Markup.shp” name, such as “John Doe Capturx Markup.shp” 

2. The user removes the Capturx Markup layer “John Doe Capturx Markup.shp” from 

the table of contents. 

3. The user then attempts to import a new ink session. 

4. Capturx will inform the user the markup layer can‟t be found and ask the user to 
create a new layer. The user then has the choice: 

a. Create a new Capturx Markup Layer and choose where to save it 

The user will be informed that all Markup ink will be defaulted to “Redline 

Markup”, the other colors (green/blue markup) will turn into redline markup 

b. Or the user can manually find the “John Doe Capturx Markup.shp” Capturx Markup 

Layer by entering its location path and name into the window in step (a). 

  

Pen Does Not Turn-on when You Remove the Cap 

 Make sure the pen is fully charged. 

 Insert the pen into the USB cradle to recharge the battery. 

  

Pen Does Not Charge when Connected to the Docking Station. 

1. Make sure the computer is turned on. 

2. Check if the docking station is connected to the computers USB port — verify that 

the USB cable is tightly inserted into the dock bottom plug. 

3. Make sure the pen is fully inserted. 

4. Try using another USB port on the computer. 

  

Contacting Adapx Technical Support 

You can also contact the Technical Support department directly by email or by phone: 

  

 techsupport@adapx.com 

 866-208-9673 

 Care and Maintenance of the Pen 

Your pen is a product of superior design and craftsmanship and should be treated with care. 

The suggestions below will help you protect your warranty coverage. 
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1. Although the pen is designed to work on all-weather environments, try to keep the 

device dry. Precipitation, humidity, and all types of liquids or moisture can contain 

minerals that can corrode electronic circuits. 

2. Do not use or store the device in dusty, dirty areas. Its electronic components can be 

damaged. Always keep the cap on when you are not using the pen. 

3. If possible, try not to store the device in hot areas, as with any electronic 

components and equipment. High temperatures can shorten the life of electronic 

devices, damage batteries, and warp or melt certain plastics. 

4. Do not store the device in freezing areas. When the device returns to its normal 

temperature, moisture can form inside the device and damage electronic circuit 

boards. 

5. Do not drop, knock, or shake the device. Rough handling can break internal circuit 

boards and fine mechanics. 

6. Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the 

device. 

7. The preceding suggestions apply to your battery, charger, or any enhancement. If 

any device is not working properly, contact Adapx Technical Support. 

  

Changing the Ink Cartridge 

You can change the ink cartridge by using the ink cartridge removal hole. This section takes 

you through the removal steps. The ink is under pressure, so be careful when changing the 

cartridge that you don‟t break the tip. 

  

To change the ink cartridge: 

  

1. Remove the cap and place the ink cartridge in the hole provided on the shirt clip. 

2. Gently pull to extract the cartridge. 

3. Insert the new cartridge and press to fully seat. 

  

For more information on the pen and docking station, see the following topics: 

  

Charging and Using Your Pen 

Downloading Data from Pen to ArcMap 

  
1/11/10 
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